
Reviewer’s Guide

ADOBE®ROBOHELP® 10
Taking content to your users where and when they need it

Multiscreen HTML5 brings new single-sourcing versatility for technical writers, 
documentation teams and instructional designers who 
create Application Help, Knowledge Bases, Policies and 
Procedures and eLearning content with unsurpassed ease-
of-use. By removing the technology roadblocks, you can 
focus on content. This release offers dramatic new 
workflows that make it easier than ever to create, import 
and deliver online and print content in a familiar, author-
friendly environment.

For your audience on the go, content 
follows with Multiscreen HTML5 single-
sourcing

Technical communications professionals depend on Adobe to future-proof them for 
the exploding world of multiple screens and devices. Future-proofing means Adobe 
RoboHelp 10 recognizes what is a popular device or screen size today may be replaced 
by another still to come! As a technical communications professional you need to be 
ready to deliver.

This release provides the power to prepare you for publishing to virtually any device 
with any screen size. That delivery may be online like web delivery or offline like eBooks 
or even native applications. Imagine, creating your own native mobile application and 
installing your help system or knowledge base right on the device and run without an 
internet connection. Now you can even create Context Sensitive Help for mobile 
applications with a special application programming interface (API) for iOS and 
Android developers. 

But Multiscreen HTML5 is just the beginning of the story. This release brings you major 
new solutions such as an end to end integration with Microsoft SharePoint and an even 
more powerful than ever Review and Collaboration Solution.

If you are part of a multi-author team, you will especially want to learn about how 
Adobe RoboHelp 10 makes it easier to keep team members and subject matter experts 
"in sync" so that content is accurate and up to date. This Reviewer’s Guide first offers a 
summary of these each new workflow and solution and then takes you to a more 
detailed view.
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Now you have mobile-friendly Multiscreen 
HTML5 to deliver content to any device, no matter 
what the screen size

Single Sourcing just got better! Modern, frameless HTML5 output, not only looks better, 
it performs better for the end user. Information can be richer, yet easier to access. 
Authors can also enrich topics with metadata to lead readers to the right answers.

From iPhones and iPads to Android Galaxy Tab, Kindle Fire, Android Phone and 
Desktop, Adobe RoboHelp 10 has you covered! Support for modern HTML5 output and 
CSS3 means authors are no longer limited to the old-fashioned and restrictive frame-
based "tri-pane" window. Convenient "presets" of common screen sizes are ready-to-
use and authors can specify their own custom screen sizes  if they choose. Each screen 
size can be mapped to a different screen layout so that the appearance of the content is 
right for the device. (Read more on page 13)

Choose from ready-made layouts or create your own with the 
Screen Layout Editor

The out-of-the-box Screen Layouts that are provided, are independent of your project 
content. They are created in the Screen Layout Editor using CSS and a variety of 
Multiscreen HTML5 Widget Placeholders. Everything from Search boxes to browse 
buttons to Tabbed Panels and everything in between is added with a widget. The 
Screen Layout Editor helps you position the structure of various elements so that you 
can mix and match widgets to create a layout that suits your needs. (Read more on 
page 15)
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Context-sensitive help for mobile apps 

Mobile apps need help too! So, now you "have a help app for that!" Easily deliver help 
content for mobile apps using a library of Adobe APIs. Enable users to call a default help 
screen or jump to context-based help depending on the feature being used. View the 
help content within the app or on the local browser available on the mobile device. For 
more, see Context-sensitive help for mobile apps. (Read more on page 19)

Automatic screen-based content optimization
Authors may want to customize the way certain features work as they move to 
Multiscreen HTML5 output. You can:

• Optimize each screen profile based on the size of the output screen by converting 
auto-size or text-only pop-ups to hyperlinks,

• Change absolute image and table sizes to relative sizes. 

• Enable the pinch-to-zoom feature, and replace SWF content with Adobe Captivate® 
HTML5 files on iOS devices. (Read more on page 17)

Make it look as good in print as in a web browser 

Media queries are a convenient way to change the look and feel of your content 
depending on the output medium. For example, you may want a page that is printed to 
look different than when the page is viewed in a web browser. Use the Style pod to 
define and apply styles and define the media query. Choose the media view in your 
editor to view content to see how it will be rendered. (Read more on page 21)

Preview output 

Click View > Multiscreen Preview to check out the appearance of your content rendered 
across many types of browsers and screens such as smartphones, tablets, and desktops. 
(Read more on page 16)

Search Engine Optimization (SEO-friendly) output 

Make your Multiscreen HTML5 content even more search-friendly. Users will find 
relevant content faster by assigning a unique URL to each help page. Then use the 
metadata menu to define search keywords, project synonyms, and stop lists to make 
search results more powerful. (Read more on page 31)

Integration with Adobe® Captivate® HTML5 eLearning 

Easily integrate HTML5.MP4 or Flash SWF content either imported or created on-the-fly 
with Adobe Captivate. Enhance your help files with show-me demos and how-to video 
tutorials. To see one, go to the Salesbuilder Animated Tour topic in the Salesbuilder 

“Creating exceptional 
customer experiences 
involves delivering the 
right information to the 
right people at the right 
time in the right format 
and language. But 
increasingly, it also 
means making your 
content available to 
customers on the device 
of their choosing. With 
the versatile multiscreen 
HTML 5 publishing 
capabilities, RoboHelp 10 
makes it easy to port your 
customer support and 
procedural content to 
iPhone, iPad, Kindle Fire, 
and other mobile devices 
out-of-the-box. The 
preview functionality 
adds an additional level 
of confidence, helping 
you ensure the 
experiences you create 
will dazzle your 
customers.” Scott Abel, 
The Content Wrangler, Inc.



Adobe RoboHelp 10 Reviewer’s Guide 4

sample project. There is also a new Rapid Step by Step Authoring workflow that 
integrates with RoboHelp content. (Read more on page 22)

Now you have the eBook layout to support EPUB 3 and Kindle 
Format 8 (KF8)

Deliver content to smartphones, tablets, and eBook readers in EPUB 3, KF8 and MOBI 
formats. Publish to devices (such as iOS and Android™ smartphones and tablets, 
Amazon Kindle, Barnes and Noble NOOK™, Sony Reader™) and reader apps (such as 
Adobe® Digital Editions, Calibre, Aldiko, and iBooks). (Read more on page 36)

New Features and Enhanced Workflows in Adobe 
RoboHelp 10

Enhanced importing of existing content including Automapping of styles from 
Microsoft Word and Adobe FrameMaker

There are even easier workflows to import content from other sources, such as Adobe® 
FrameMaker®, Adobe Captivate®, PDF, Microsoft Word, DITA, XHTML, and CHM. For 
example, style mapping from FrameMaker and Word has been enhanced and you can 
now create or import Adobe Captivate HTML5 format eLearning tutorials. In the 
Salesbuilder sample project, you can see how the Corporate Travel Microsoft Word 
document has been linked to this project. You will also find an Adobe Captivate 6 
HTML5 Video which can be seen if you generate one of the Multiscreen HTML5 Single 
Source Layouts. It is in the Salesbuilder Animated Tour topic.

In addition, there is a new Automapping feature for Microsoft Word and Adobe 
FrameMaker that conveniently allows the author to map styles from those applications 
to RoboHelp topics upon import. Automapping picks up the imported Microsoft Word 
or FrameMaker document styles and maps them to RoboHelp style names. (Read more 
on page 45)

Multi-file Find and Replace 

There is an all new and robust Multi-file Find and Replace tool in its own pod for editing 
content more conveniently. Search for text with multiple parameters, edit your search 
queries, view search results in a list, use pre-populated search filters, set a default 
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Search path, and look up regular expressions and wildcard characters. (Read more on 
page 40)

User Defined Variables (UDV) 

Control and customize content better by applying a User Defined Variable to a wider 
range of content, including the Topic Title and Table of Contents. Automate updates by 
simply making a single change to the UDV value in the UDV pod. To see this in action, 
right click on this topic and choose "Topic Properties." You will see that the About 
RoboHelp 10 User Defined Variable has been inserted in to the Topic Title. This is also 
used in any topic where that variable has been placed. (Read more on page 41)

Glossary definitions even more easily exposed to your readers. 

By popular request! The author can now choose Glossary terms to reveal definitions as 
text popups or even tooltips in addition to the expanding hotspot.  Read details in 
Output Enhancements. (Read more on page 42)

Automate commonly used procedures with the RoboHelp 
Scripting Engine and API 

RoboHelp is virtually unique among help authoring tools in having an extremely 
extensible scripting capability. There are many "out of the box" scripts for common 
tasks and now, you can enable event-based executions of functions within a script 
rather than relying on manual interventions. Use the scripting pod to generate custom 
reports, automate frequently used workflows, and even extend the functionality of 
Adobe RoboHelp 10. To access these scripts, click View > Pods > Script Explorer. 

Access to user-generated content with smart new 
Search features

Intelligent, searchable content

Create a superior search experience for your users by empowering them with the ability 
to view the total number of search results, search for all words in a string, and apply 
Conditional Build Tags (CBTs) on external search content.

To expose this unique feature and make it easier to use, External Content Search now 
has its own pod for easily adding terms and URLs with CBTs applied where required. 
(Read more on page 31)
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Editable image tags 

Improve accessibility for your content by setting your own attributes for the Title and 
Alt tags in the HTML code when an image is added to the content. 

Efficiently collaborate and rapidly review

Out-of-the-box integration with Microsoft SharePoint

Enable better version control on all multiscreen help projects by publishing directly to a 
SharePoint document library or folder. Publish directly to a SharePoint site from within 
RoboHelp. This may be in.aspx format if preferred.) Project team members can then 
check files in or out and maintain history records. (Read more on page 27)

Multi-authoring productivity

Enable real-time collaborative content creation and increase productivity in multi-
authoring environments. 

• Manage assets across users and projects with Microsoft® SharePoint. 

• Reuse shared assets from a common repository on a shared location

Enhanced PDF-based reviews

Expand the scope of PDF-based reviews by filtering topics based on the table of 
contents and including dynamic HTML content in the workflow. Now also review 
expanding and drop-down text, import comments related to them, and track 
changes.(Read more on page 22)

Tracking usage added to Feedback Analytics

End-user Feedback Reports are key to improving your content quality as you better 
understand your user's behavior. This is accomplished by tracking key user metrics. 
Adobe® RoboHelp® Server 9* software feedback reports can be customized to gain 
insight into usage patterns and better meet their needs.(Read more on page 49)

*Adobe ® RoboHelp ® Server 9 is a separate product from Adobe RoboHelp 10, and must be 
purchased separately. 
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Projects can now be stored and worked on from a network 
location

Performance is always enhanced when a RoboHelp project is opened on the author's 
local drive. However, Adobe RoboHelp 10 now makes it possible for projects to be 
located on a network drive and worked on directly.

Import Content from many formats and output to 
many types

But before we get into the details of this workflow, let's step back for a minute and take 
a look at the overall input/output of RoboHelp which is what all this collaboration is 
part of. First, authors can import many source documents in many formats that can be 
brought into the project. Sometimes the technical communicator drafts the content 
right in RoboHelp. In other cases, content is received from other authors or subject 
matter experts to be imported. Once the content is brought into the project, there are 
many outputs that can be generated. Adobe RoboHelp has long been the leader of 
single sourcing. 

An author might want the convenience of keeping only one project up to date. But, the 
author often has many types of output and many different audiences or channels to 
receive this content. For example, the project may be used to create traditional outputs 
such as WebHelp or Printed documentation. Or the author may choose from many 
other newer formats such as AIR Help for automatic updating or EPUB for handheld 
devices and ebook readers. The RoboHelp project can also output directly to a 
SharePoint site or perhaps publish to the Adobe RoboHelp Server 9 which provides 
Feedback Report Analytics for constant content improvement. RoboHelp remains at 
the core as the tool that helps the author make all this happen smoothly.
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All of this output goes into Help Systems, Knowledge Bases, Policies & Procedures, 
eLearning Content, Product Manuals

Existing favorites authors come to expect from 
RoboHelp

While this Reviewer's Guide focuses on new workflow solutions, we don’t want to forget 
the many good reasons Adobe RoboHelp has become so popular in the first place. If 
you are new to RoboHelp, here is a recap of features introduced in previous versions:

• Single Sourcing - Adobe RoboHelp software continues its innovative history of 
helping authors publish to multiple channels with more output formats (print and 
online), all within one single project.

• Dynamic User-Centric Content (DUCC) - Delivering personalized content to the 
right people at the right time. 

• AIR Help - a fast-growing and popular solution to keeping content updated and 
taking advantage of Web 2.0 commenting. All presented in an attractive and easy 
to navigate user interface.

• XML support for DITA 

• An XHTML editor with clean code that can be W3C validated right within 
RoboHelp.

• Powerful search - RoboHelp provides many tools to make content findable. These 
include topic-level search keywords, project-wide synonyms, phrase search, 
boolean expressions and optional search ranking.

• Section 508 compliance for enabling important accessibility functionality while 
maintaining a single source of content.

• Master Page templates for consistent look and feel with placeholders for 
Breadcrumbs and Mini-TOCs

• Snippets - Reusable blocks of content can be placed throughout a project making 
it easy to swap out the content for quick updating. 

• Conditional Build Tags - Authors can assign tags to content that can be excluded 
when the output is generated. One single source project can be customized for 
many audiences. 

• Multiple TOCs, Indexes and Glossaries - Versatile workflow for multiple 
audiences

• Multiple Document Interface (MDI) - Have more than one topic open at a time for 
quick switching.

• Workspaces (also known as Environments) - Create author-defined Workspaces 
which can be customized and saved.
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• Custom toolbars and menus - Provide the most comfortable workspace for the 
author.

• Scripting - Scripts that automate tasks and generate new outputs such as Eclipse 

Help or EPUB format are provided. Authors can also create their own “macros” to 
automate tasks.

• Visual editors for Cascading Style Sheets, Tables and Multilevel Lists for taking 
some of the guesswork out of managing styles, lists and tables.

Translation workflows are smooth with Adobe RoboHelp 

“Our projects are translated into over 20 languages with Trados and I never had a 
problem” - customer on Adobe RoboHelp forum. Here are some of the many 
advantages provided by RoboHelp for translation and localization:

• Unicode support for 35 languages

• The Multiple Document Interface (MDI), which allows editing of topics side by side
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• Ability to have multiple tables of contents, indexes, and glossaries in different 
languages

• The ability to define a language at the topic and even paragraph levels in addition 
to the project.

• The LANG attribute is used for spell checking, thesaurus, Smart Indexing and 
creating the search index.

• The language attribute specified at the paragraph level is given the highest 
preference.

• Clean XHTML code

Installation of Adobe RoboHelp 10

If you do not already have Adobe RoboHelp 10, a trial version may be downloaded from 
www.adobe.com/go/try/robohelp. For system requirements, see the end of this guide.

When the installation dialog appears, select radio buttons for Adobe RoboHelp 10, 
Adobe PDF Creator Add-on (deselect if you have a different compatible product) and 
the Adobe ExtendScript Toolkit.

Note: Opening a project and upgrading it to Adobe RoboHelp 10 will make it 
incompatible with previous versions. Therefore, it is best practice to install trial versions 
on non-production machines as well as to backing up projects before opening in a new 
version of RoboHelp. 

Don't miss the Sample Projects for examples and tips

Sample Projects to explore and learn - Three Adobe RoboHelp 10 Sample Projects 
(Employee Care, Global Site Consult and Salesbuilder-help) are included in the 
installation. They use a fictional company, Whirl the World Travel which has an online 
policies and procedures manuals as well as context sensitive Adobe AIR Help for its AIR 
Application, called Salesbuilder.  Global Site Consult is designed to provide Context 
Sensitive Help for mobile applications.

Open these samples to get an immediate feel for RoboHelp. Be sure to open the 
AUTHOR_INFO_READ_FIRST folder in either sample to give you a headstart.

Notice this view shows off the author-friendly Design Editor with the brand new Review 
Pane showing at the bottom. This is where authors and their subject matter experts  
can participate in keeping the project “in sync”. On the left is the RoboHelp Project 
Manager which helps you easily track of hundreds or thousands of assets that are part 
of your project.

http://www.adobe.com/products/robohelp
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Try it! Exercises

The Try it! Exercises in this guide are designed to use the Sample projects.

To access the Samples Projects, do one of the following:

1. Open RoboHelp by double-clicking the desktop icon named “Adobe RoboHelp 10 
HTML”.  Or, Click Start > Run > type “robohtml” and click OK.

2. RoboHelp will open to its start page. 

3. On the start page, click the Open folder icon.

4. From the Open Project dialog click the Sample icon in the lower left panel.

5. Open the EmployeeCare folder (sample project).

6. Double-click on the EmployeeCare.xpj (RoboHelp's project file).

7. After the project opens, maximize the RoboHelp application window. You will see 
the project open in a view similar to this screenshot.

8. The same steps can be taken to open the Salesbuilder or Global Site Consult sample 
projects.

Worth the upgrade. Whether switching or 
upgrading, this is a release not to miss!

Tight budgets require your tools to work harder and be up to date. Budget 
tightening means your tools must work harder and be scalable in today's economic 
reality. Adobe RoboHelp 10is your insurance policy against falling behind as needs 
change and grow. Switching or upgrading assures a good return on investment (ROI) 
that will make everyone happy. (Read more on page 49) 

• Adobe RoboHelp is most often described as “author-friendly” and easy to use. (Yet, 
some competitor tools are often described as having a “steep learning curve” or “an 

“In my 20 years of using 
and teaching RoboHelp, 
I’ve never seen so many 
new workflows and 
features in a single 
release, making it an 
upgrade no-brainer.”

” John Daigle, Evergreen 
Online Learning, LLC
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interface only a techie could love”). The friendly interface provides the Adobe 
RoboHelp author with an immediate payoff.

• Affordable solution. Many organizations find that Adobe RoboHelp provides a 
robust, scalable solution for a lot smaller investment than more expensive Content 
Management Systems.  
For example, Adobe RoboHelp 10 can be purchased for less than $1,000 US and 
attractive upgrades are available for as little as $399 US. RoboHelp is also available 
on an economical monthly or annual subscription basis as part of the Adobe 
Technical Communication Suite 4.

• Start developing content immediately without learning complicated “techie” 
interfaces and workflows that don't work the way you do.

• It's scalable and can easily grow with your needs.

• The new Review and Collaboration workflow solution streamlines your workflow 
and can save lots of time and money as the team communicates more accurately 
and efficiently.

• Extras are provided without additional purchase such as RoboScreen Capture, 
RoboSource Control and Extended Scripting automation. Adobe Reader is free for 
reviewers to use. 

• The tight integration and affordability of the Adobe Technical Communication 
Suite 3 is an assurance of Adobe's commitment to excellence and constant 
improvement suggestions incorporating thousands of user suggestions over  
many years.

• With the Adobe Technical Communication Suite, the savings are even greater. Five 
Adobe applications are included for less than half the cost if purchased separately.
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Multiscreen HTML5 
Single Source Layouts

Now you have mobile-friendly Multiscreen 
HTML5 to deliver content to any device, no matter 
what the screen size

From iPhones and iPads to Android Galaxy Tab, Kindle Fire and Desktop, Adobe 
RoboHelp 10 has you covered! Support for modern HTML5 output and CSS3 means 
authors are no longer limited to the old-fashioned and restrictive frame-based "tri-
pane" window. 
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“The new Multiscreen 
output in Adobe 
RoboHelp 10 lets me 
quickly and easily publish 
one set of files for all 
devices. The Help system 
queries the device, and 
formats the output based 
on screen size rules I set 
up.”

Matt Sullivan, Independent 
Adobe Certified Instructor

Choose from a Gallery of prepared Screen Layouts 

The New Screen Layout dialog shows a Gallery of out-of-the-box layouts which can be 
modified in the Screen Layout Editor to suit your branding or color scheme. 

Modify the Screen Layout Pages for your own branding and 
color scheme

For example, perhaps you would like to change out the logo shown in the screenshot 
below. Double-click on it and browse to the location of the new logo. Click OK to 
replace. Use the Multiscreen Widget tool bar in the upper right of the Screen Layout 
Editor to insert major structural elements such as:

• Tabbed Panel of Table of Contents, Index, Glossary

• Browse Sequence buttons

• Print button

• Hyperlinks

• Horizontal Accordion tabs

...and many more. In addition to the widgets, authors can access the Screen Layout 
Properties to fine-tune the CSS Attributes for the layout.
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“The addition of HTML5-
based multiscreen 
outputs, CSS3, and 
support for Media 
Queries moves Adobe 
RoboHelp 10 into the 
mobile space in a big 
way—from smartphones 
to tablets and beyond. At 
the same time, RoboHelp 
maintains its familiar 
interface and feature set 
for those authors that 
aren’t yet ready to add 
mobile to their single 
source outputs and 
workflows. RoboHelp 10 
is a well thought-out, 
flexible, and future-
oriented extension of 
RoboHelp by Adobe. Nice 
job!”

Neil Perlin, President, 
Hyper/Word Services

Many ways to Preview your work on different screen sizes

See how your designs work on different sized screens using the built-in Multiscreen 
Previewer. You can also view with a Screen Profile in an emulation of a device.
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Automatic Screen Optimization so content adapts to the device

Convenient "presets" of common screen sizes are ready-to-use and authors can specify 
their own custom screen sizes  if they choose. Each screen size can be mapped to a 
different screen layout so that the appearance of the content is right for the device.

The screen profiles and layouts are shown in Project Set-up. Here you will see all the 
profiles and layouts available to the project. You can add and delete as required.

When generating the Multiscreen HTML5 Single Source Layout, you can select 
Optimization settings so that the content will “flow” and adapt to fit the target screen. 
For example, popups are commonly used for larger desktop screens, but are not always 
supported by smartphones and other devices. Items like image and table sizes will also 
adjust to fit the screen. Optimization can also properly deliver the new Adobe Captivate 
6 HTML5 files for eLearning content.
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Responsive Design promotes fluid layouts

Notice how the four images and text of the web browser on the left automatically 
adjusts to single stacked graphics on the phone device.

Use the Multiscreen HTML5 Single Source Layout to generate 
content

The screen profiles are mapped to the layouts within the new Multiscreen HTML5 
Single Source Layout. All the screen profiles in the project will always be listed on the 
left. On first accessing this dialog all the profiles will also be listed on the right and be 

“Adobe RoboHelp 10 
represents an important 
step in supporting the 
next generation of 
software applications. As 
more and more 
computing is done 
through mobile devices, 
it is vital to adjust Help to 
match. The support of 
HTML5, Media Query, and 
Multiscreen output in 
RoboHelp 10 assists 
technical communication 
professionals in reaching 
their objectives.”

Joe Welinske, President, 
WritersUA
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mapped to a screen layout. If you don't want an output for all the devices, simply 
highlight them on the right and use the Remove Screen Profile(s) button.

Context-sensitive help for mobile apps 

Mobile apps need help too! So, now you "have a help app for that!" Easily deliver help 
content for mobile apps using a library of Adobe APIs. Enable users to call a default help 
screen or jump to context-based help depending on the feature being used. View the 
help content within the app or on the local browser available on the mobile device. For 
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more, see Context-sensitive help for mobile apps. The APIs are installed on the author’s 
computer along this or similar path: C:\Program Files (x86)\Adobe\Adobe RoboHelp 
10\CSH API

Shown below are CSH Test Tools for both the Android as well as iOS applications so that 
the developer can make sure the right help topics are accessed at the right time.

Create Native Mobile Apps (.apk)

An author can create a “native” mobile application so that the RoboHelp project 
becomes an installable application stored right on the device. This way, no Internet 
connection is required!
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Click File > Generate > Native Mobile App to access the options available. For details 
please see the online help topic.

Enhanced CSS3 management 

Create CSS styles either using a built-in visual style editor or choose a new HTML code 
editor for those who like to edit directly. View and modify attributes, edit the <img> 
tags, and format hyperlinks, text boxes, and block elements. You can also modify and 
create new DIV tags as well as manage Media Queries. For example, you can use media 
queries to style images and hyperlinks differently for printed and online content.
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A launchpad for eLearning: Adobe Captivate 6 and HTML5 
output for mobile devices 

Authors are becoming “trainers”. Traditional online help authors are being tapped on 
the shoulder to produce eLearning and training materials. More and more, RoboHelp is 
being used as an eLearning platform. 

Support for new media technologies with time-saving techniques. Relieve friction 
and frustration with many time-saving authoring enhancements, and a host of new 
improvements including rich media support such as.MP4 and Flash Video (FLV) and 
Adobe Captivate 6 HTML5 videos and 3D modeling technologies.

Generate Adobe Captivate 6 HTML5 videos on-the-fly or import existing output

When an Adobe Captivate 6 HTML5 video is created within RoboHelp or imported, all 
the associated output files are brought along for maximum compatibility. For example, 
if a browser or device does not support Flash SWF format, the HTML5 content is 
delivered. Conversely, if the browser does not yet support HTML5 output, then the SWF 
file is delivered with the popular Adobe Flash Player installed on more than 90% of 
desktops and laptops worldwide. So, the Adobe RoboHelp workflow covers all the 
bases!

Rapid Step by Step Authoring with Adobe Captivate 6 
integration

When used with the Adobe Technical Communication Suite, authors now have a way to 
generate short reference guides and handouts of their Adobe Captivate 6 projects by 
generating on-the-fly or importing them into Adobe RoboHelp 10. This is particularly 
useful for Job Aids and step by step tutorials.

Adobe RoboHelp 10’s Review and Collaboration 
Solution

Content must be kept in sync. Keeping other authors and SMEs up to date can be 
daunting. Because there are constant changes to content, there is a crucial need for 
authors to keep “in-sync” with subject matter experts and documentation team 
members. At the same time, your end users would like to participate in the content 
generation as well. Powerful new Review and Collaboration workflows using the 
popular Adobe Acrobat PDF provide the answer. It is a great way to save time, money 
and frustration all around.
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In this next section there are more details on three major workflow to the solution of: 

• Adobe PDF Based Review (Author-to-Subject Matter Expert)

• Comments and Comment Moderation found in Adobe AIR Help (Authors and 
end-user community)

• Track Changes - As the project is worked on, changes are marked and highlighted. 
There is also 

• a record of who made them and when. (Author-to-Author)

PDF Review even more powerful in Adobe RoboHelp 10

A round-trip workflow - A major benefit is that you can select topics individually or 
based on status, which makes for a smooth workflow in a multi-author environment. 
This includes Snippets and Master Pages as well! Then, authors can import the 
comments back into RoboHelp and choose to accept or reject comments as they see 
fit. 

Expand the scope of PDF-based reviews by filtering topics based on the table of 
contents (See screenshot below)
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• Include dynamic HTML content in the workflow

• Review expanding and drop-down text and import comments related to them

• Track changes

A crucial need for writers is to keep their authoring colleagues and Subject Matter 
Experts "in the loop" so that requested changes can be synchronized during 
development. New Review and Collaboration workflows using Adobe technology 
make this possible. All the reviewers need is the free Acrobat Reader software.

A major benefit is that you can send all or just a few of the topics in the project for 
review.

You may now send a PDF containing the content of some or all of the topics in the 
project for Subject Matter Expert review. PDF based review is described in more detail 
in the online help for Adobe RoboHelp 10.

There is no limit on the number of reviewers or topics. This is really scalable to fit your 
requirements. When PDFs are created for review there are many options for hosting the 

PDF. They can be hosted on an internal server, Acrobat.com or a Microsoft SharePoint 
server.

There are three ways to create a PDF Review. All the reviewers need is the free Adobe 
Reader software. 
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• Send For Shared Review
Creates a PDF and uploads it to an internal server, Acrobat.com or a Microsoft 
SharePoint server location for shared review. This option requires that the initiating 
RoboHelp author has Acrobat X Pro installed. The reviewers need only have the free 
Adobe Reader. (Acrobat X Pro comes with the Adobe Technical Communication 
Suite 4.)

• Create A Local PDF

Creates a PDF and saves it to a location you specify. You then distribute the file by 
your preferred means.

• Attach For eMail Review

Creates a PDF and attaches it to a new email message opened in your email client. 
You can complete the message and send it to the reviewers.

After all reviewers have made their comments, the author then uses the Review > 
Import Comments from PDF command. A Review Pane shows a list of comments or 
changes. By double clicking the comment, the author can easily go to the particular 
topic and accept or reject all. Let’s take a look at a scenario of a round trip tour to see 
how a Shared Review can benefit multi-author teams.

When the reviewer receives the PDF, there are many Annotation options available to 
them when they comment, as you can see in the screenshot below.

Back in the RoboHelp application when the Shared Review is finished, the author clicks 
Review > Import comments from PDF. In the Review Pane they can see who made the 
comment or change, the date and the type as shown in the screenshot below.
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Management of tracked changes among fellow authors

An important and much-requested capability in Adobe RoboHelp 10 is being able to 
track changes. Authors can turn on the new Track Changes feature (Review > Track 
Changes) and RoboHelp will then highlight additions and deletions. Comments can 
also be added.

You can look at projects created by other authors and use the Review Pane to accept or 
reject their changes. You can also add your own comments to give the original author 
some feedback.

Reviewers can quickly see what has changed. 

In Tools > Options you need to enter your name as the Reviewer and other Adobe 
RoboHelp 10 authors should do the same. Any comments or edits will then have the 
reviewer's name associated with them.

You can generate a layout in the usual way. There may be an Alert dialog asking you to 
confirm. By clicking Yes, the layout will be generated as if all the changes had been 
accepted but the changes will still be shown in the source files. 

“Tracking alone is worth 
the upgrade for me. Now I 
can easily see my team's 
changes and ensure 
consistency,”  
Peter Grainge, 
Documentation Manager, 
Advanced Business 
Solutions
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End to end workflow - Out-of-the-box integration 
with Microsoft SharePoint

A growing amount of knowledge bases and policies and procedures content is stored 
on SharePoint sites. There is also a need to access that content from mobile devices. 
That makes RoboHelp’s solution even more valuable.

• The business value of SharePoint is growing

• Content’s value is increasing

• Business users see more value from platform interactions

Publish Multiscreen HTML5 content to SharePoint for both 
desktop and mobile access

In addition to publishing WebHelp to SharePoint, you can also publish in Multiscreen 
HTML5 format. This includes the ability to publish in the.aspx format in accordance with 
Microsoft’s security and compatibility recommendations. By integrating Adobe 
RoboHelp 10 and SharePoint you can provide your readers with easy and powerful 
access to the Search Engine as well. To access this dialog, create or click on any 
Multiscreen HTML5 Single Source Layout and open the SharePoint (Native) Settings.

“I’m excited about the 
new Adobe RoboHelp 10 
Multiscreen output where 
we can deliver content to 
different screen sizes 
such as tablets. We use 
RoboHelp to help our 
financial services clients 
document their policies 
and procedures in an 
online format. We have 
clients who are exploring 
the option of providing 
their managers

with tablets. The ability 
to output their 
procedures to a format 
designed for a tablet is 
terrific—it really opens 
up the possibilities!”

Pam Harrison, Co-owner, 
Lightext, Inc.
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By publishing to SharePoint using the Multiscreen Single Source Layout, your content 
can be accessed via the desktop as well as mobile devices. The main SharePoint search 
facility is integrated to bring up RoboHelp project results or readers can use the 
customized search engine focused on the RoboHelp content.
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“The Resource Manager is 
so much more versatile, 
especially for multi-
authoring teams,” Rick 
Stone, ShowMeSolutions

Resource Manager - “live linking” integrates with SharePoint

Do more with less - Adobe RoboHelp 10 helps teams of multiple authors do more with 
less! A key component of collaboration is to share reusable resources that can be “live 
linked” so that the author knows when the original file has been changed. 

Facilitates source and version control for a multi-author environment - Read below 
to see how version control solutions can help teams of multiple authors avoid getting 
out of step as changes occur. 

Drag and drop to create a link - Use an asset presented inside the Resource Manager 
pod by dragging from the pod to the project. That creates a link so that when the 
original graphic is changed, the RoboHelp author is notified and given the option to 
update to the new version. This can be used across different RoboHelp Projects among 
many authors. 

Asset links prevent duplication and maintain consistency - When Adobe RoboHelp 
10 establishes a link between any resource in the Resource Manager. If an asset is 
changed in some way, RoboHelp  notifies you of the change.

Then, you are able to easily update the project by clicking Sync.  At first its icon will be 
green showing that it is in sync with the original. 

Changes are made! - If anyone then edits this shared image, the linking icon color will 
change to red, as shown below with the SearchLocation.png image. So, to make sure 
the image reflects the latest change, the author right clicks and selects Sync to update 
the graphic.
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Try It! (Add a Microsoft SharePoint Document Library)

To add a Resource Manager location (including Microsoft SharePoint):

1. Open the Salesbuilder-Help sample project.

2. Open the Resource Manager pod (View > Pods > Resource Manager).

3. Click the Add Shared Location icon in the Resource Manager toolbar.

4. Navigate to a preferred location on a network or local drive or of course, a Microsoft 
SharePoint document library. Create a folder and click OK. That becomes the 
Shared Location for the Resource Manager.

5. In Resource Manager, click Create Folder and name it Images.

6. Drag any image in the Project Manager (such as ContactsIcon.png) to the Resource 
Manager > Images folder. At this point, the graphic may be shared but it is not yet 
linked.

7. To link the image, first open a topic in the Design Editor. Drag the ContactsIcon.png 
from the Resource Manager into the topic. 

8. Click Save All and you will see that the icon on the ContactsIcon.png is now green!

RoboHelp and SharePoint Source control supports this 
collaborative environment 

SharePoint now becomes your version and source control system

This helps authors keep in sync. In addition to SharePoint, RoboHelp supports 
RoboSource Control and many third party source control applications such as these:

• RoboSource Control 3.1 (Which comes with Adobe RoboHelp 10 at no extra charge)

• Team Foundation Server 2010 and 2008

• Perforce

• Microsoft Visual Source Safe 5.0

• Any other version control application that supports Microsoft Source Code  
Control API



Adobe RoboHelp 10 Reviewer’s Guide 31

Another tremendous time-saver is 
that you don't have to leave your 
RoboHelp project to perform source 
control actions. They are all 
integrated into the RoboHelp 
interface so that many of the common 
source control functions are right  
at hand. 

Smart Publishing to SharePoint with Adobe RoboHelp 10 (Click the play button to 
view an Adobe Captivate animated demonstration)

Enhance the Search Experience options

The Search settings allow you to define different search parameters for each profile. 
You may want to show a smaller number of Search Context characters on devices with 
small screens. Note that RoboHelp 10 allows you to exclude specific file types from the 
search results. You can also enable External Content Search so that users have the 
benefit of viewing the latest updates from user-generated Web 2.0 content.
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“A key to any Help system 
or knowledge base is a 
powerful search engine. I 
was pleased to find 
Adobe RoboHelp 10 has 
made enhancements to 
search with custom 
metadata, and powerful 
External Content Search.”

John Daigle, President and 
Owner, Evergreen Online 
Learning, LLC

External Content Search now has its own pod to expose it better to the author. Another 
enhancement is the ability to apply conditional build tags (CBTs) to the search terms.

Access to community-generated content with new search workflows

External Content Search metadata provides access to community-generated 
content

Guide your readers to community-generated content. This might be found on blogs 
and wikis or other Web 2.0-enabled sites such as Twitter, Facebook, LinkedIn and user 
forums. Of course, you remain in control to provide trusted guidance to that 
information. 

You become a curator of external content in much the same way as a museum curator 
selects the best of the best for an exhibit. 

You can provide trusted resources for your readers by pre-selecting blogs and websites 
that you have reviewed and know that they are useful. After all, you are the champion 
of the end user and you make it your business to know what your users want and need. 

External Content Search makes it possible to enter search metadata. The author 
creates keywords that are linked to a URL (such as Google, Bing or any resource). When 
the end user uses RoboHelp's search facility and searches for these keywords, the links 
are listed among the search results - and ranked in the top position. The resulting link 
presents a “live” site inside the topic pane. 

Reuse these prepared External Content Search URLs - Once you have created  
the URL metadata, you can export and import them for reuse in multiple  
RoboHelp projects.

It's a search-centric world. Is your content “findable”? - Topic-level search Keywords, 
project-wide synonyms, phrase search, boolean expressions and optional search 
ranking provide authors powerful tools to help make content findable.

How it Works - In this next scenario, the author determined that the online knowledge 
base is for programmers and developers of Adobe AIR applications. They develop 
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applications for their Sales organization. So, it would be helpful to direct them to a 
particular website that has the most relevant content. Obviously, if someone entered 
“Sales” into a search box, there would be an overwhelming number of results returned. 
To make sure that the preferred URL appears in the live WebHelp topic pane, an 
External Content Search item was prepared, along with pre-selected search terms and a 
website. Now, when the user searches for “sales” the first ranked result is the  
favored website!

Popular eBooks and reading devices - perfect for 
deploying policies and procedures and online 
manuals

Streamlined EPUB1 output makes it easy for authors to distribute - No longer 
content to sit at a PC, today people want their information and multimedia within 
reach, wherever they happen to be. With the abundance of multimedia devices and 
digital gadgets, publishers are looking for means to take their content to the mobiles, 
eBook readers, tablet PCs and more. 

1. The EPUB logo is a trademark of the International Digital Publishing Forum.
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Device independence with the EPUB format standard - Technical communication 
toolkits need to have the flexibility to “push” content out to many of the advanced 
hand-held devices for true anywhere, anytime consumption. Adobe RoboHelp 10 has a 
“wizard-driven” workflow that makes the process easy.

EPUB is a new standard output to accommodate a growing number of eBook readers 
and mobile devices. The devices are eBook readers (such as Barnes & Noble's Nook, etc.) 

Tablets (Apple iPad, BlackBerry Playbook1, etc.) and even cellular telephones such as 
Motorola's Droid. 

Publish to devices (such as iOS and Android™ smartphones and tablets, Amazon Kindle, 
Barnes and Noble NOOK™, Sony Reader™) and reader apps (such as Adobe® Digital 
Editions, Calibre, Aldiko, and iBooks).

1. Copyrights and trademarks are property of their respective owners.

“We’ve seen a significant 
increase in our 
international sales, an 
increase in demand for 
our publications 
domestically, and we 
expect that growth to 
continue. It’s a direct 
result of our ability to 
produce and deliver high-
quality EPUBs faster and 
more cost-effectively 
than ever because of the 
Adobe Technical 
Communication Suite.” 
Kevin Siegel, President, 
IconLogic
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Here is a chart showing the phenomenal sales of eBooks

EPUB is an XML-based file format designed to reflow text according to screen size, 
giving users a format to organize and read digital publications on mobile devices. The 
EPUB file format was developed and is maintained by the International Digital 
Publishing Forum (IDPF), a nonprofit standards organization composed of commercial 
trade and academic publishers, software companies, consumer electronics 
manufacturers, and publishing and accessibility associations. The standard was 
developed with the participation of over 60 companies and organizations and was 
unanimously approved by IDPF members. Today there are more than 200 members 
(companies like Adobe, Google, Apple, Nokia, Barnes & Noble etc.) in the IDPF.

http://www.idpf.org
http://www.idpf.org
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Source: International Digital Publishing Forum

Top features of EPUB
• Text reflow according to screen size—ideal for reading on mobile devices, eBook 

readers, and tablets

• Open, nonproprietary file format standard developed and maintained by the IDPF

• Simple table of contents and navigation implementation

• Advanced control with font embedding and CSS styling

• Ability to embed images, objects, and multimedia files

• Interoperability for unencrypted files

eBook Single Source Layout for EPUB 3 and Kindle Book

Try It!

So that you can see how this works, we have provided a procedure for creating an 
eBook for both the EPUB 3 and Amazon Kindle MOBI - KF8 formats. Both Employee Care 
and Salesbuilder sample projects have an example. We will use the one in Salesbuilder 
for this scenario.
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When you first access the eBook Settings screen, you will not be able to access any of 
the options on the left until you have set the Kindle Generator Path. When you click the 
button shown, you can browse to where you have installed it. If it is not already 
installed, there will be a link to the download page on Amazon's site.

When finished with the settings, click Save and Generate

To create an eBook

In the Salesbuilder sample project, double click the eBook Single Source Layout
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1. Fill out the options as shown

2. Indicate the publishing Meta Information and a cover page image

3. Click Save and Generate

Once you create the EPUB output file, you will want an eBook reading application in 
order to view the output on your computer, such as Adobe Digital Editions or the 
Firefox browser EPUB Add On. Shown below is a page from Adobe Digital Editions.
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EPUB 2.0.1 is also supported

While EPUB 3 is the latest, RoboHelp 10 still supports the EPUB 2.0.1 format. You can run 
a script from Script Explorer and click File > Generate > EPUB 2.0.1output. For more 
details see online help.

Many time-saving enhancements to the Topic 
Editor

Adobe RoboHelp 10 adds many new usability enhancements and boosts the author’s 
productivity
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Multi-file Find and Replace 

There is an all new and robust Multi-file Find and Replace tool in its own pod for editing 
content more conveniently. Search for text with multiple parameters, edit your search 
queries, view search results in a list, use pre-populated search filters, set a default 
Search path, and look up regular expressions and wildcard characters.

In the screenshot above, you can see were the Find what for "data" was found in 10 
topics giving the author the choice of replacing any or all instances with the word, 
"information". Use the Multi-file Find and Replace tool to globally find and replace text, 
HTML tags, and attributes in the current project or across files and folders. Set options 

“Importing from some 
sources can introduce 
characters that are not 
within the HTML 
document character code 
set so the output can 
display strange 
characters. The improved 
Find and Replace 
function in Adobe 
RoboHelp 10 provides 
user friendly 
functionality to rid my 
code of non-HTML 
standard characters and 
replace them with true 
HTML standard 
characters.”

Gary Bowen, Master 
Technical Writer
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in the Find and Replace pod. RoboHelp displays the results in the Find Results pod and 
also lets you open each modified file in the Find Results Editor pod (HTML view). 

Here is a quick summary of the process:

1. Select Edit > Find And Replace In Files.

2. Select View > Pods > Find and Replace In Files > Find And Replace Options.

3. Specify what to find. 

There are many options including:

• Begins With

• Ends With 

• Phrases

• Does Not Contain

• Regular Expressions are supported as well as finding text across multiple lines. 

For more details read the online help topic, "Find and Replace in Files".

Topic Titles can now have User Defined Variables assigned

Control and customize content better by applying a User Defined Variable to a wider 
range of content, including the Topic Title and Table of Contents and Index. Automate 
updates by simply making a single change to the UDV value in the UDV pod. With this 
enhancement, you can use UDVs instead of actual product names and or feature names 
in topic titles and avoid rework if these names undergo frequent or last-minute 
changes. In RoboHelp 10, you can use UDVs not just in topic contents, TOCs, or index 
terms but also in topic titles.

Try it!
1. To see this in action, go to the About Adobe RoboHelp 10 in the Salesbuilder 

sample project. 

2. Right click on the topic and choose "Topic Properties." You will see that the About 
RoboHelp 10 User Defined Variable has been inserted in to the Topic Title. This is 
also used in any topic where that variable has been placed!

Control + Click jumps you to your target topic in Design Editor

Control + click on link to jump to an Adobe RoboHelp 10 topic in the Design Editor. 

Try it for yourself in the Salesbuilder or Employee Care sample projects. 

“The UDVs in topic titles 
in Adobe RoboHelp 10 
make it much easier to 
update titles that are 
subject to change at a 
later date.”

- Robert Hinesley,  
Senior Technical Writer 
Comet Computer GmbH
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Glossary definitions even more easily exposed to your readers. 

By popular request! The author can now choose Glossary terms to reveal definitions as 
text popups or even tooltips in addition to the expanding hotspot. 

This is accomplished using the built-in Scripting Engine and accessed from the Script 
Explorer.

Extend-Script Engine now has Event-based script triggers

One of the unique features of RoboHelp is that you can extend it on your own with 
Extend Script which is built-in and accessed from the Script Explore (see screenshot 
above). There are useful scripts that are ready-made, or now you can enable event-
based executions of functions within a script rather than relying on manual 
interventions. Use the scripting pod to generate custom reports, automate frequently 
used workflows, and even extend the functionality of Adobe RoboHelp 10.

Paste Rich HTML content

Adobe RoboHelp 10 enables you to copy content from applications such as Microsoft 
Word, Microsoft Excel and web pages inside browsers, then paste into the RoboHelp 
topic.

Clear Formatting and Reset Style - Away with inline styles! 

One constant frustration for authors is importing content from documents written 
without proper styling. When imported into RoboHelp, "inline styles" or "overrides" can 
defeat your hard work in designing a proper CSS. Clear Formatting and Reset Style are 
new commands that let your CSS control the styling without rude inline styles getting 
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in the way. You make a selection and click Format > Clear formatting. All styling is 
cleared. On the other hand, Reset Style is done from the Styles and Formatting pod. In 
this scenario, Resetting a style resets both CSS and inline styles from a single HTML 
element by removing style related attributes like "class" and "style" from selected HTML 
element tag. Other CSS code remains. 

View generated output locally with Google Chrome

Previous limitations of Google Chrome made it difficult to view locally. Adobe 
RoboHelp 10 now accommodates viewing of generated output using Google Chrome. 
This is useful for previewing content locally so the author can check their output.

Authors choice for multiple topic editing

Some help authors found themselves quickly overwhelmed with way too many tabs 
open.

Adobe RoboHelp 10 addresses this by allowing the help author to choose whether only 
a single topic is edited or whether multiple topics are edited.

To configure this setting, click Tools > Options > General tab and configure the option 
labeled: Allow editing of multiple topics.

Now Microsoft HTML Help CHM files can have skins, too!

Yes, normally CHM files do not have skins, but now they do with Adobe RoboHelp 10. \

Try it!
1. Generate a WebHelp Single Source Layout

2. Open the Script Explorer and run the WebHelp to CHM Converter.jsx script

3. You now have a CHM file with all the customized color and branding you prefer.
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Add PDFs or 3D models using iFrames - Take advantage of displaying rich media such 
as 3D models or “live” PDFs from inside an Inline Frame (iFrame). This works if you 
generate WebHelp, WebHelp Pro, FlashHelp, FlashHelp Pro, Air Help or browser-based 
AIR Help as your output. 

• Manipulate the 3D Model in real time - You can “grab” the model and turn it 
completely around, separate the parts or even create a live movie of the action! 

• In addition, if you add PDFs to an iFrame, the text embedded in the PDF becomes 
searchable by your users. 
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Enhanced Adobe FrameMaker and Microsoft 
Word import and linking

In RoboHelp 10, FrameMaker document import and linking includes the following 
additional enhancements:

Automap styles when importing Adobe FrameMaker and 
Microsoft Word 

Automap picks up RoboHelp style names and maps them to the imported FrameMaker 
document’s styles. 

Instead of having to map each FrameMaker format with a corresponding RoboHelp 
style, use Automap to automatically map similar style names from the selected CSS in 
RoboHelp.

Enhanced pagination and topic naming of imported or linked 
content

In RoboHelp 10, you can paginate a document or split the document into topics based 
on paragraph styles or a marker type. In RoboHelp 10, you can use a combination of 
both paragraph styles and marker type. This enhancement gives you more ways to 
implement pagination. For example, you can now specify that a document should be 
paginated on Heading 1 with some exceptions or a document should be paginated on 
Heading 1 and in some cases on Heading 2 as well. Topic names are based on the topic 
name pattern specified in the Other Setting tab of the Conversion Settings dialog box 
or the marker text specified in the FrameMaker document for the marker type used for 
pagination.

Support for FrameMaker-generated TOC and index in 
FrameMaker DITA map import and linking

FrameMaker now creates a TOC and index while converting a DITA map as a book with 
FrameMaker component. When you import or link a DITA map in your RoboHelp 
project, you can use the FrameMaker-created TOC and index to create a TOC and index 
or add to an existing TOC and index in the project.

U3D view links in imported or linked FrameMaker content

FrameMaker 11 allows you to create hyperlinks to a U3D view. When you import or link 
FrameMaker content, these hyperlinks work if the U3D view and all objects linking to it 
are placed in an anchored frame. While conversion, RoboHelp generates a PDF for each 
U3D view placed in an anchored frame and embeds the PDF in an iframe in the topic. 

“With our previous 
cumbersome process, it 
took days to create a final 
product. The team would 
have to repeatedly re-
create content due to 
editorial errors or 
changes from 
engineering staff, and 
then generate the build 
all over again. Now that 
we are using Adobe 
FrameMaker together 
with RoboHelp, we can 
actually keep up,” Leslie 
Vice, Marketing 
communications specialist, 
FDM Software
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During conversion, if RoboHelp finds that a U3D view is linked to any object outside the 
anchored frame, it removes the hyperlink.

Support for Windows 7 - 64-bit and Microsoft Office 2010 - Import and export 
content using Microsoft Office 2010. 

Dynamic User-Centric Content (DUCC) - Delivering personalized 
content to the right people at the right time. 

A personalized experience for the user - Dynamic User-Centric Content is a way to 
personalize the experience of looking for information by letting the user choose by role 
or by location or other helpful categories. This filtered content capability has been 
added to WebHelp and AIR Help. It guides the user to the most accurate information 
they are seeking. DUCC can be customized according to user roles, geographical areas, 
or even among multiple product types - or any other categories the author creates. 

DUCC recognizes that there are often multiple audiences with one overall group of 
users. For example, in an online help system there may be a suite of software products 
installed and the user wants to filter out everything except a certain product.

To set up DUCC, the author simply defines Content Categories that allow the end user 
to dynamically change what they see in the output help system. 

Here is an example. As the author of an 
online knowledge base for multi-national 
company your employees may be provided 
access to thousands of topics. This can be 
overwhelming if someone is looking for a 
needle in a haystack. Now, there’s a choice.
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Adobe RoboHelp Server 9 Audience Feedback 
Analytics

Content requires constant feedback. Your content must be in a constant feedback 
loop of improvement. Adobe RoboHelp Server Feedback Analytics can help you 
succeed with content optimization. Adobe RoboHelp Server 9 provides the following 
major benefits: 

(For greater detail, download the full 
Reviewer’s Guide for Adobe RoboHelp Server 9) 

Here are the highlights of new functionality:

• Analytical feedback reports - A set of out of the box reports allow you to hone in 
on specific statistical aspects of your help system’s usage. They include these seven 
reports:

1. Frequently searched terms

2. Frequently viewed topics

Role Based

If you are a retired employee, you may not 
want to wade through tons of content when 
you make a search to look up the dates of 
coming retirement parties. Select your “role” 
and your TOC, Index, Search and Glossary 
items are filtered to present only this subset 
of content!

Geographical Based

Or, you may be in the Mexico City office and 
don't want to look through all the Paris and 
New York Office-related material. The simple 
dropdown menu below shows how easy it is 
for those employees to filter the content! It 
can even be delivered with a Language 
interface for that particular Content 
Category.

“Adobe RoboHelp Server 
9 Web Administrator is a 
dream to work with and 
very easy to configure. 
The Feedback Analytics 
and the ability to publish 
to different audiences 
and get customized 
feedback reports will 
help us keep our content 
relevant and helpful”

Colum McAndrew, IDBS, UK

http://www.adobe.com/support/documentation/en/robohelp/9/AdobeRoboHelpServer9_ReviewersGuide.pdf
http://www.adobe.com/support/documentation/en/robohelp/9/AdobeRoboHelpServer9_ReviewersGuide.pdf
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3. Search terms with no results

4. Search trends

5. Usage Statistics

6. Frequently accessed CSH

7. Help system errors.

• Ranked search results - Search results are ranked according to relevance, 
displayed with some context, allowing the end user to make an informed decision 
on the topic to display.

• User friendly searching - The ability to specify wildcard characters and boolean 
expressions, as well as search on synonyms, makes the end user search experience 
a truly powerful method of finding the required content.

• Separate reportable areas - Different websites, called areas, can be set-up on the 
Adobe RoboHelp Server to allow different help systems to be published. For 
example, if different versions of an application are supported, each version’s help 
file could be contained in its own area. The feedback analytics can be run on one or 
more area.

• Secure access - Access to an area can be restricted by the help author to those with 
a valid Adobe RoboHelp Server user id and password. For example, the content for 
a Human Resources department may contain sensitive information that users in 
other departments must not see. Maybe a test area is used prior to a help file’s 
release and a production area once live. In these scenarios the Human Resources 
department help system and test area would be restricted, while the live area is 
available to everyone without authentication.
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• Customizable report data - Reports can be customized in any number of ways 
including by a data range or to include / exclude particular pieces of metadata.

• Filtering reports on a subset of data - Help systems can be published to areas set 
up on the Adobe RoboHelp Server, thereby allowing reports to be refined by 
running them on a sub-set of data.

• Flexible and secure access - Each area can be protected if required, forcing users 
to enter a user id and password to access the documentation. Users and user 
groups can also be assigned different permissions thereby allowing flexibility in 
what a user can perform.

• Exportable report data - Report data can be exported to a comma separated 
(.CSV) file, enabling the rich statistical analysis to be performed in other statistical 
applications. Additionally reports can be printed (including to a file).

Take the following real world examples:

• An international food company based in the US used the Frequently Viewed 
Content report inside the Adobe RoboHelp Server to highlight the areas of the help 
system that were viewed the most. Armed with this information they added a 
Frequently Asked Questions topic at the top of each major book in their Table of 
Contents, highlighting the questions that had been asked. 

• A US bank used Adobe RoboHelp Server’s unanswered questions report to 
highlight search terms used by their end users that were returning no results. As a 
result their help authors were able to revisit the documentation to add or change 
the content as required.

• A UK software company providing scientific research applications used various 
reports to highlight dialogs with context sensitive help calls that were frequently 
being used. This feedback analytic data enabled the help author to go to the 
developers and change the design of the dialog to make it more intuitive.

Adobe RoboHelp Server 9 makes searches more successful. 

Search Ranking and Search Context are now part of Adobe RoboHelp Server 9 
experience.
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More Resources for Adobe RoboHelp Information

Adobe TV 
http://tv.adobe.com/channel/technical-communication/ 

Adobe Technical Communication Blog 
http://blogs.adobe.com/techcomm/

Adobe RoboHelp User Forums 
http://forums.adobe.com/community/robohelp

Adobe RoboHelp Help & Support 
http://www.adobe.com/support/robohelp/

Adobe OnDemand Seminars 
http://www.adobe.com/cfusion/event/

http://www.adobe.com/support/robohelp/
http://www.adobe.com/support/robohelp/
http://www.adobe.com/support/robohelp/
http://www.adobe.com/support/robohelp/
http://forums.adobe.com/community/robohelp
http://forums.adobe.com/community/robohelp
http://blogs.adobe.com/techcomm/
http://blogs.adobe.com/techcomm/
http://tv.adobe.com/channel/technical-communication/
http://tv.adobe.com/channel/technical-communication/
http://www.adobe.com/cfusion/event/index.cfm?event=list&type=ondemand_seminar&loc=en_us


Adobe RoboHelp 10Reviewer’s Guide 52

Version Comparison Chart: 
Compelling reasons to switch or upgrade 
to Adobe RoboHelp 10

Yes 
No
Enhanced

Product features RoboHelp 
10

RoboHelp 
9

RoboHelp 
8

RoboHelp 
7

AUTHORING

Productivity Boost

Preview topic/output in multiple browsers

Automated context sensitive help (CSH) authoring for 
mobile apps

Automatic content resizing to fit output screen

Preview output across screen types

Conversion of auto-size or text-only pop-ups to 
hyperlinks

Changing absolute image and table sizes to relative 
sizes

Pinch-zoom on iOS devices

Adobe Captivate HTML5 output on iOS devices

Search and Replace

Event-based script triggers

Preview topic and output in multiple browsers

Snippets 

Convert snippets to HTML text

Visual CSS Style Editor 

User-defined variables 

User-defined variables in table of contents and index 

Option to edit multiple topics or single topic

Master pages (topic templates)
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Breadcrumbs 

Mini-TOC

Scripting and automation 

Automated context sensitive help (CSH) authoring

Standards Support

Multiscreen HTML5 support

EPUB 3 support

Enhanced CSS3 support

EPUB standard for eBooks, mobile phone, tablets and 
other handheld devices.

XHTML standards support

HTML editor and no Kadov tags 

XML import and output 

Unicode and translation workflow support 

World Wide Web Consortium (W3C) compliance 
checking

Section 508 compliance for accessibility

Multi-authoring Support

Merge and publish multiscreen HTML5 content

Enhanced project performance over enterprise 
networks

Out-of-the-box Microsoft SharePoint integration

Live Link support for Microsoft Word files 

Version Comparison Chart: 
Compelling reasons to switch or upgrade 
to Adobe RoboHelp 10

Yes 
No
Enhanced

Product features RoboHelp 
10

RoboHelp 
9

RoboHelp 
8

RoboHelp 
7
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Integrated version control support for Adobe® 
RoboSource Control™, Team Foundation Server, 
Perforce, Visual SourceSafe, and other SCC compliant 
apps

Integrated Version control support for RoboSource Control, 
Team Foundation Server, Perforce, Visual Source Safe other 
SCC compliant apps

Ease of Use

Style pod

Media view in editor

Ability to view media queries

Glossary pop-up

Usage reports on build tags 

Hyperlinks, pop-ups, and image maps 

Multiple tables of contents, indexes, and glossaries support

Automated wizards 

Graphics and multimedia support 

Dictionary, Spell Check, Thesaurus, and Auto Correct 

Insert line and page break

Enable/disable notifications

REVIEW and COLLABORATION

TOC-based reviews

DHTML content review

Conditional Build Tags

Version Comparison Chart: 
Compelling reasons to switch or upgrade 
to Adobe RoboHelp 10

Yes 
No
Enhanced

Product features RoboHelp 
10

RoboHelp 
9

RoboHelp 
8

RoboHelp 
7



Adobe RoboHelp 10Reviewer’s Guide 55

Socially-enabled code for Facebook Likes

Socially-enabled code placement for Twitter Follows

Author-to-author, author-to-SME, and author-to-end-
user collaboration via PDF, live linking, RoboHelp 
review management, or Adobe AIR Help

Shared reusable resources

Community-generated content, comments, feedback; 
external web content

Moderation enabled end-user commenting workflow

Review workflow – PDF based

Review workflow – Client based

Adobe FrameMaker® integration 

Multi-author support 

PUBLISHING

Multiscreen HTML5 output

Screen profiles

Screen layouts

New eBook SSL

Native mobile apps support

Adobe FlashHelp® output

JavaHelp output

OracleHelp for Java™ output

Media queries

Version Comparison Chart: 
Compelling reasons to switch or upgrade 
to Adobe RoboHelp 10

Yes 
No
Enhanced

Product features RoboHelp 
10

RoboHelp 
9

RoboHelp 
8

RoboHelp 
7
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Smart Publishing with Microsoft SharePoint

EPUB format output for mobile devices, tablets, and 
eBook readers

Output to SharePoint

TOC-based output

Adobe PDF support

Option to exclude unreferenced topics from output

Dynamic user-centric content (DUCC)

Single sourcing to multiple channels

Adobe AIR Help 

Microsoft Word 2007 and 2010 support 

Adobe PDF support 

EPUB format output for mobile devices, tablets, and 
eBook readers

Output to SharePoint

TOC-based Output

Option to exclude unreferenced topics from output

Option to exclude unreferenced baggage files from 
search

END-USER SEARCH

Unique URLs for pages

Metadata menu

Keyword-based search

Linguistic synonyms

Version Comparison Chart: 
Compelling reasons to switch or upgrade 
to Adobe RoboHelp 10

Yes 
No
Enhanced

Product features RoboHelp 
10

RoboHelp 
9

RoboHelp 
8

RoboHelp 
7
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Stop lists

External Content Search

Search results with ranking (optional), Boolean 
operators, and metadata 

Phrase search

Search capabilities for PDF and Microsoft Office 
documents 

Option to exclude unreferenced baggage files from 
search

Adobe AIR

Adobe AIR Help on Google Chrome

Adobe AIR® output 

Adobe AIR Help Skin Editor

Adobe AIR Comments 

Adobe AIR Comment Moderation

MULTIMEDIA & eLEARNING

Editable Title and Alt tags

Adobe Captivate® integration 

FLV video support 

3D models 

TRANSLATION & LOCALIZATION

Multiple language support 

Unicode and translation workflow support 

ADVANCED FEATURES

Version Comparison Chart: 
Compelling reasons to switch or upgrade 
to Adobe RoboHelp 10

Yes 
No
Enhanced

Product features RoboHelp 
10

RoboHelp 
9

RoboHelp 
8

RoboHelp 
7
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Mobile Help API library

Advanced feedback analytics to content optimization in 
Adobe Robohelp Server 9

ADDITIONAL ENHANCEMENTS

64 bit OS support

Adobe RoboScreenCapture® utility 

Adobe Acrobat® Capture® integration 

Chrome - browser support

Pod environment

IPv6 support 

Version Comparison Chart: 
Compelling reasons to switch or upgrade 
to Adobe RoboHelp 10

Yes 
No
Enhanced

Product features RoboHelp 
10

RoboHelp 
9

RoboHelp 
8

RoboHelp 
7
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System Requirements 

For updates to system requirements, visit www.adobe.com.

Adobe® RoboHelp® 10 is available in the following languages: 

• English

• French

• German 

• Japanese

Processor Intel® Pentium® 4 and above

Operating system

Microsoft® Windows 7, Windows® XP with Service Pack 3, or Windows Vista® with Service 
Pack 2 

32 and 64 bit

RAM 1GB of RAM 

Hard disk space
3.1GB of available hard-disk space for installation; additional free space required during 
installation (cannot install on a volume that uses a case-sensitive file system or on 
removable flash storage devices) 

Media DVD-ROM drive 

Monitor 1024x768 display (1280x800 recommended) with 16-bit video card

Other

This software will not operate without activation. Broadband Internet connection and 
registration are required for software activation, validation of subscriptions, and access to 
online services. Phone activation is not available.

Once the product is purchased and installed, online product activation is mandatory 
within 30 days from installation. Activation is by internet only. Without activation, the 
product will be usable for up to, but not beyond, 30 days. 

Supporting 
Statement

This product may allow you to extend its functionality by accessing certain features that 
are hosted online, including CS Live online services (“Online Services”), provided you have 
a high-speed Internet connection. Online Services are only available for users age 13 and 
older. The Online Services, and some features thereof, may not be available in all countries, 
languages, and/or currencies and may be discontinued in whole or in part without notice. 
Use of the Online Services is governed by separate terms of use and by the Online Privacy 
Policy, and access to some services may require user registration. Some Online Services, 
including services that are initially offered at no charge, may be subject to additional fees 
and require a separate subscription. For more details and to review the applicable terms of 
use and Online Privacy Policy, visit www.adobe.com. 

http://www.adobe.com
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About Adobe Systems Incorporated

Adobe revolutionizes how the world engages 
with ideas and information—anytime, 
anywhere and through any medium. For more 
information, visit www.adobe.com.

Better by Adobe.™

This document was created and published 
exclusively with Adobe Technical 
Communication Suite.

http://www.adobe.com
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Copyright and Legal Information

© 2012 Adobe Systems Incorporated. All rights reserved.

Adobe RoboHelp 10 Reviewer’s Guide for Windows®

This guide, as well as the software described in it, is furnished under an end user license agreement 
accompanying such software and may be used or copied only in accordance with the terms of such license. 
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is defined at 48 C.F.R. §2.101, consisting of “Commercial Computer Software” and “Commercial Computer 
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Readjustment Assistance Act of 1974 (38 USC 4212), and Section 503 of the Rehabilitation Act of 1973, as 
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